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Multi-Site Support
This chapter contains general information about multi-site environments, as 
well as information on deploying a multi-site environment for your T-Server. 

This chapter is divided into the following sections:
 Multi-Site Fundamentals, page 39
 ISCC Call Data Transfer Service, page 41
 ISCC/Call Overflow Feature, page 60
 Number Translation Feature, page 64
 Network Attended Transfer/Conference Feature, page 72
 Event Propagation Feature, page 74
 ISCC Transaction Monitoring Feature, page 81
 Configuring Multi-Site Support, page 81
 Next Steps, page 95

The following instructions apply to both local and remote switches and 
T-Servers. Because different vendor switches can be installed at the local and 
remote locations, this chapter covers several, but not all, possible 
configurations. To help determine which sections of this chapter apply to your 
situation, refer to Table 2 on page 56 and Table 3 on page 61.

Multi-Site Fundamentals
A multi-site configuration has two or more switches that belong to the same 
enterprise or service provider and that share the Genesys Configuration 
Database. (In some cases, this may include isolated partitions on a given 
switch served by different T-Servers.) The main goal of T-Server support for 

Note: Each switch/T-Server combination offers different multi-site options. 
For details describing your specific switch/T-Server environment, 
refer to the “T-Server Common Configuration Options” chapter.
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multi-site operations is to maintain critical information about a call as it travels 
from one switch to another.

T-Server supports multi-site operations using its Inter Server Call Control 
(ISCC; formerly called External Routing), which supports the following 
functions:

• Call matching—To link instances of a call distributed across multiple sites 
and to re-attach essential data associated with the call (ConnID, UserData, 
CallType, and CallHistory). The following T-Server features support this 
capability:
 ISCC Call Data Transfer Service (active external routing)—when 

requested by a T-Server client by specifying the desired destination in 
the location parameter, and also with various ISCC strategies 
performed by direct dial or by using the Transfer Connect Service. See 
“ISCC Transaction Types” on page 48 and “Transfer Connect Service 
Feature” on page 59.

 Inter Server Call Control/Call Overflow (ISCC/COF) feature (passive 
external routing)—applicable when calls are overflowed to another site 
either directly or manually (see page 60).

 Number Translation feature (see page 64).
 Network Attended Transfer/Conference (NAT/C) feature (see page 72).

• Call data synchronization between associated call instances (ISCC 
Event Propagation)—To provide the most current data to call instances 
residing on remote T-Servers. The following T-Server features support this 
capability: 
 User Data propagation (see page 75)
 Party Events propagation (see page 76) 

Note: When ISCC detects call instance reappearance on a given site, the 
call is assigned a unique ConnID and the user data is synchronized 
with the previous call instances. This ensures that ConnIDs 
assigned to different instances of the same call on a given site are 
unique.

Note: ISCC automatically detects topology loops and prevents 
continuous updates.

Note: In distributed networks, Genesys recommends using call flows that 
prevent call topology loops and multiple reappearances of the same 
call instance. This approach ensures that all T-Servers involved with 
the call report the same ConnID, and also optimizes telephony trunk 
allocation by preventing trunk tromboning.
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The T-Server configuration contains information about other T-Servers with 
which it will communicate. T-Server uses this information to connect with the 
other T-Servers. During this “handshake” process, T-Servers exchange 
information about the following parameters:

• Protocol type

• Switch type

• Server name

• Location name (switch name)

• T-Server role (primary or backup)

To complete the handshake process, T-Servers exchange messages about the 
current condition of the links to their switches. After the handshake process is 
complete, T-Server is ready to support a multi-site operation.

ISCC Call Data Transfer Service
Because ISCC supports active external routing, T-Servers that serve different 
switches (usually on different sites) can exchange call data when a call is 
passed from one switch to another. With this functionality, T-Server provides 
its clients with the following additional information about each call received 
from another switch: 

• The connection identifier of the call (attribute ConnID).

• Updates to user data attached to the call at the previous site (attribute 
UserData). 

• The call type of the call (attribute CallType)—In multi-site environments 
the CallType of the call may be different for each of its different legs. For 
example, one T-Server may report a call as an Outbound or Consult call, but 
on the receiving end this call may be reported as Inbound.

• The call history (attribute CallHistory)—Information about 
transferring/routing of the call through a multi-site contact center network.

Figure 7 shows the steps that occur during a typical external routing (ISCC) 
transaction. Note that the location where a call is initially processed is called 
the origination location, and the location to which the call is passed is called 
the destination location.

Note: Load-sharing IVR Servers and Network T-Servers cannot be 
designated as the destination location for ISCC, except when 
cast-type is set to dnis-pool. Consult the Universal Routing 
Deployment Guide for specific configuration details.
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Figure 7: Steps in the ISCC Process

ISCC Call Flows

The following section identifies the steps (shown in Figure 7) that occur during 
an ISCC transfer of a call.

Step 1

A client connected to the T-Server at the origination location requests this 
T-Server to pass a call with call data to another location. For this purpose, the 
client must specify the location parameter (Attribute Location) when calling a 
corresponding T-Library function. ISCC processes the following T-Library 
requests:

• TInitiateConference

• TInitiateTransfer

• TMakeCall

• TMuteTransfer

• TRouteCall

• TSingleStepTransfer

Step 2

Upon receiving a client’s request, the origination T-Server checks that the:

1. Connection to the destination T-Server is configured in the origination 
T-Server Properties dialog box.

2. The connection to the destination T-Server is active.
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3. The destination T-Server is connected to its link.

4. The origination T-Server is connected to its link.

If these four conditions are met, the origination T-Server determines the 
transaction type that will be used for passing call data to another location in 
this transaction. The following possibilities exist: 

• The client can request what ISCC transaction type (or simply transaction 
type) to use by specifying an appropriate key-value pair in the Extensions 
attribute of the request. The key-value pair must have a key equal to 
iscc-xaction-type and either an integer value as specified in the 
TXRouteType enumeration (see the Voice Platform SDK 8.x .NET (or Java) 
API Reference) or a string value equal to one of the following: default, 
route, direct (or direct-callid), direct-network-callid, 
direct-notoken, direct-ani, direct-uui, direct-digits, reroute, 

dnis-pool, pullback, or route-uui.

• If the client does not specify the transaction type in the request or specifies 
the default transaction type, T-Server checks the Switch configuration for 
the transaction type configured in the Access Code (or Default Access 
Code) properties:
 If the Route Type property of the Access Code is set to any value other 

than default, T-Server uses the specified value as the transaction type.
 If the Route Type property of the Access Code is set to the default 

value, T-Server uses the first value from the list specified in the 
cast-type configuration option configured for the destination T-Server. 
If no value has been specified for the cast-type option, the default 
value of route is used as the transaction type.

After the origination T-Server determines the requested transaction type, it 
determines if the destination T-Server supports this transaction type.

You must list the transaction types T-Server supports in the cast-type 
configuration option.

The origination T-Server issues a request for routing service availability and 
sends it to the destination T-Server. The T-Server request contains data that 
should be passed along with the call to the destination location. This data 
includes the transaction type, ConnID, UserData, CallType, and CallHistory.

The timer specified by the request-tout configuration option is set when the 
origination T-Server sends the request. If either the specified timeout expires 
or the call is abandoned before the origination T-Server receives a response 
from the destination T-Server, the operation is considered failed. In this 
scenario, the origination T-Server:

Note: For more information on Access Codes and Default Access Code, 
see “Switches and Access Codes” on page 83.
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1. Generates a request to the destination T-Server to cancel the request for 
routing service.

2. Sends EventError to the client that requested the service.

3. Deletes information about the request.

Step 3

The destination T-Server receives the request for routing service availability 
and checks the requested type of routing. Depending on the ISCC transaction 
type, it stores the request information and, when appropriate, allocates access 
resources for the coming call. For example, an External Routing Point is 
allocated when the transaction type is route, and an Access Resource of type 
dnis is allocated when the transaction type is dnis-pool. 

If resources are unavailable, the request is queued at the destination location 
until a resource is free or the origination T-Server cancels the request. If the 
request is canceled, the destination T-Server deletes all information about the 
request.

If resources are unavailable because of incorrect configuration, the destination 
T-Server returns an error event to the origination T-Server.

Step 4

If resources are available, the destination T-Server generates a positive 
response and the timer is started for the interval specified by the timeout 
configuration option of the destination T-Server.

Step 5

If the origination T-Server receives a negative response, it sends an EventError 
message to the client and clears all data about the request. 

If the origination T-Server receives the confirmation about routing service 
availability, it processes the client’s request and sends a corresponding 
message to the switch. The timer on the origination T-Server is also started for 
the interval specified by the timeout configuration option of the destination 
T-Server.

Step 6

The origination switch processes the T-Server request and passes the call to the 
destination switch. 

Note: The resource-allocation-mode and resource-load-maximum 
configuration options determine how resources are allocated. For 
option descriptions, refer to the “T-Server Common Configuration 
Options” chapter.
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Step 7

If the call arrives at the destination switch, the switch generates an alerting 
event. 

The destination T-Server waits for the call no longer than the interval specified 
by the timeout configured on the destination T-Server. If the call is not 
received at the destination location within this interval, the destination 
T-Server issues a failure notification to the origination T-Server, deletes all 
data about the request, and, when appropriate, frees the resources previously 
allocated for the request.

If either the specified timeout expires or the call is abandoned before the 
origination T-Server receives a response from the destination T-Server, the 
operation is considered failed. In this case, the origination T-Server:

1. Generates a request to the destination T-Server to cancel the request for 
routing service.

2. Responds to the client that requested the service in one of the following 
ways:
 If the origination T-Server has already sent a response to the request 

the client sent in Step 1, the origination T-Server supplements its 
response with EventRemoteConnectionFailed.

 If the origination T-Server has not yet sent a response to the client, the 
origination T-Server sends EventError.

3. Deletes information about the request.

Step 8

If the destination T-Server matches the arrived call, it updates the ConnID, 
UserData, CallType, and CallHistory attributes with the data received in the 
request for routing service availability. The connection ID is updated as 
follows:

The arrived call is assigned the ConnID that is specified in the request for 
routing service availability, but only if this ConnID does not coincide with the 
ConnID of a call that has existed at the destination site. If two such ConnIDs are 
identical, the arrived call is assigned a new unique ConnID.

For direct-* transaction types (where the asterisk stands for a callid, uui, ani, 
or digits extension), the call reaches the destination DN directly.

For the transaction types route and route-uui, the call first arrives at an 
External Routing Point from which it is routed to the destination DN. The call 
info is updated when the call reaches the External Routing Point. An External 
Routing Point is considered free when the first alerting event (EventQueued or 
EventRouteRequest) is distributed.

Please keep the following issues in mind when using the ISCC feature:
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• If routing from a dedicated External Routing Point to the destination DN 
fails, T-Server considers the transaction failed. However, the ConnID, 
UserData, CallType, and CallHistory attributes are updated. Then, 
T-Server attempts to route the call to one of the Default DNs configured 
for this External Routing Point.

• If the destination T-Server did not receive a request for routing service 
availability, but a call arrives at an External Routing Point, T-Server 
considers the call to be unexpected and routes the call to the DN specified 
by the dn-for-unexpected-calls configuration option. When no alternative 
targets are defined, the call remains at the External Routing Point until 
diverted by the switch or abandoned by the caller.

For reroute and pullback transaction types, the call returns to the network 
location. For the dnis-pool transaction type, the call reaches the destination 
DN directly.

Step 9

If, in Step 8, the call does not arrive within the configured timeout, or the 
transaction fails, the destination T-Server sends a notification of failure to the 
origination T-Server.

Otherwise, the destination T-Server notifies the origination T-Server that the 
routing service was successful and deletes all information about the request.

Step 10

The origination T-Server notifies the client that the routing service was 
successful (or failed) and deletes all information about the request.

Client-Controlled ISCC Call Flow

The following section identifies the steps that occur during a client-controlled 
ISCC transfer of a call.

Step 1 

A client, such as Universal Routing Server (URS), that is connected to the 
T-Server at the origination location detects a call to be delivered to another 
destination location.

Step 2

The client chooses a destination location and the target DN for the call. Then, it 
sends the TGetAccessNumber request to the destination T-Server for routing 
service availability, indicating the target DN and other call context (ConnID, 
UserData, and CallHistory attributes).
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Step 3

The destination T-Server receives the request for routing service availability. 
Depending on the ISCC transaction type, it stores the request information, 
including the call context. When appropriate, it allocates access resources for 
the coming call, such as External Routing Point.

If resources are unavailable, the request is queued at the destination T-Server 
until an appropriate ISCC resource is free or the client cancels the request. If 
the request is canceled, the destination T-Server deletes all information about 
the request.

If resources are unavailable because of incorrect configuration, the destination 
T-Server returns an EventError message to the client.

Step 4

The destination T-Server replies to the client with the 
EventAnswerAccessNumber message, which contains the allocated ISCC 
resource.

Step 5

The client requests that the origination T-Server delivers the call to the 
destination location using the allocated access resource.

Step 6

The origination T-Server receives and processes the client’s request, and then 
sends a corresponding message to the switch. 

Step 7

The call arrives at the destination switch and is reported to the destination 
T-Server via CTI. The call is matched by means of ISCC, based on the 
specified cast-type setting and allocated resource, and then the call is assigned 
a requested call context (such as ConnID or call data). Upon successful 
transaction completion, the destination T-Server notifies the client by sending 
EventRemoteConnectionSuccess.

The destination T-Server waits for the call no longer than the interval specified 
by the timeout that is configured on the destination T-Server. If the call is not 
received at the destination location within this interval, the destination 
T-Server issues a failure notification to the client by sending 
EventRemoteConnectionFailed, deletes all data about the request, and, when 
appropriate, frees the resources previously allocated for the request.

The destination T-Server notifies the client whether the routing service 
succeeded or failed by sending either the EventRemoteConnectionSuccess or 
EventRemoteConnectionFailure, respectively.
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ISCC Transaction Types

As switches of different types provide calls with different sets of information 
parameters, a single mechanism for passing call data between the switches is 
not feasible in some cases. Therefore, the ISCC feature supports a number of 
mechanisms for passing call data along with calls between locations. This 
section describes ISCC transaction type principles, identifies which transaction 
types are supported for each T-Server, and defines each transaction type 
(beginning with “direct-ani” on page 49).

It is important to distinguish the two roles that T-Servers play in an external 
routing (ISCC) transaction—namely origination T-Server and destination 
T-Server. 

• The origination T-Server initiates an ISCC transaction. It prepares to send 
the call to another T-Server and coordinates the process.

• The destination T-Server receives call data from an origination T-Server 
and matches this data to a call that will arrive at some time in the future.

The distinction between these roles is important because the range of 
telephony-hardware functionality often requires T-Servers to support two 
entirely different sets of ISCC transactions based on which of the two roles 
they play. For instance, it is very common for a particular T-Server to support 
many types of ISCC transactions when it takes on the origination role, but 
fewer when it takes on the role of a destination T-Server.

The ISCC transaction type reroute is a good example. Most T-Servers support 
Reroute as origination T-Servers, but very few support Reroute as destination 
T-Servers.

Determining and Configuring Transaction Type 
Support

You can find descriptions of these transaction types starting on page 49. Use 
Table 2 on page 56 to identify the transaction types your destination T-Server 
supports. A blank table cell indicates that T-Server does not support a certain 
transaction type.

You can configure the transaction types specific to your T-Server as values of 
the cast-type configuration option specified in the ISCC configuration section 
extrouter. 

ISCC Transaction Type General Principles

Generally, since most of the ISCC implementation is done at the T-Server 
Common Part (TSCP) code level, all T-Servers support certain ISCC 
transaction types. Any T-Server can act as the origination T-Server for the 
following transaction types:

• direct-ani, page 49
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• direct-notoken, page 51

• dnis-pool, page 51

• pullback, page 53

• reroute, page 53

• route (aliased as route-notoken), the default transaction type, page 54

The following transaction types are unevenly supported for both the 
origination and destination T-Server roles:

• direct-callid (aliased as direct), page 49

• direct-digits (reserved for Genesys Engineering)

• direct-network-callid, page 50

• direct-uui, page 50

• route-uui, page 55

The reroute and pullback transaction types are supported only for selected 
T-Servers in the destination role. However, if you implement this support, 
other transaction types require additional configuration and testing—even 
those that would normally be supported by default.

direct-ani

With the transaction type direct-ani, the ANI call attribute is taken as the 
parameter for call matching. Properly configured switches and trunks can keep 
the ANI attribute when a call is transferred over the network. T-Server can use 
this network feature for call matching.

direct-callid

With the transaction type direct-callid, the call reaches the destination DN 
directly from another location, and the CallID of the call is taken as the 
attribute for call matching. When a call arrives at the final destination, the 

Warning! Depending on the switch platform, it may be possible to inherit 
the ANI attribute after routing a call to a remote destination, and 
after performing a single-step transfer and other telephone actions. 
However, ISCC only works properly in scenarios where the ANI 
attribute on the destination T-Server is represented by exactly the 
same digit string as on the origination T-Server.

Typically, the ANI attribute represents the original call identifier 
(customer phone number), which guarantees that the attribute 
remains unique. However, you can use the non-unique-ani 
resource type to block ISCC from matching calls based on an ANI 
that is known to be non-unique. (See “Configuring access 
resources for non-unique ANI” on page 92 for details.)
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destination T-Server identifies its CallID, and updates the call info if the 
CallID matches.

Use this transaction type when the destination switch has the capability to 
assign to an incoming call the same network-wide unique CallID that the 
origination switch has already assigned to that call.

direct-network-callid

With the transaction type direct-network-callid, the call reaches the 
destination DN directly from another location, and the NetworkCallID of the 
call is taken as the attribute for call matching. When a call arrives at the final 
destination, the destination T-Server identifies its NetworkCallID, and updates 
the call info if the NetworkCallID matches.

Use this transaction type when the destination switch has the capability to 
assign to an incoming call the same network-wide unique NetworkCallID that 
the origination switch has already assigned to that call.

direct-uui

With the transaction type direct-uui, so-called user-to-user information (UUI) 
is taken as the attribute for call matching. Some switches make it possible to 
send a small data packet along with a call. T-Server can use this data to 
recognize a call passed from one switch to another. The destination T-Server 
generates a local unique value for UUI, and then notifies the origination 
T-Server. The origination T-Server uses a provided value to mark the call 
coming from the origination location. The destination T-Server receives a call 
and checks whether it is marked with an exact UUI value. If so, the call is 
considered to be matched.

On the Avaya Communication Manager and the Aspect ACD, UUI is referred 
to as “user-to-user information.” On the Siemens Hicom 300 switch with 

Notes: The direct-callid transaction type is used only in conjunction with 
the TRouteCall and TSingleStepTransfer function calls. It is applied 
only to the call that is in progress, and does not apply to functions 
that involve in the creation of a new call, such as TMakeCall.

For T-Server for Nortel Communication Server 2000/2100, the 
direct-callid transaction type is also applied to the TMuteTransfer 
function.

Note: To support this transaction type, you must configure Target Type and 
ISCC Protocol Parameters fields of the corresponding Switch Access 
Code in the Configuration Layer. 



Multi-Site Support ISCC Call Data Transfer Service

T-Server—Deployment Guide 51

CallBridge, UUI is referred to as “Private User Data.” On the Alcatel 
A4400/OXE switch, UUI is referred to as “correlator data.”

direct-notoken

With the transaction type direct-notoken, T-Server expects a call to arrive 
from another location to the destination DN specified in the request for routing 
service availability. When a call reaches the specified DN, T-Server processes 
the call as the expected externally-routed call.

dnis-pool

With the dnis-pool transaction type, T-Server reserves one of its DNIS access 
resources and waits for the call that has the same DNIS attribute as the name of 
the reserved DNIS access resource.

If the arrived call is matched successfully, the destination T-Server may update 
the value of the DNIS attribute of the call (along with ConnID, UserData, 
CallType, and CallHistory) with the value of the DNIS attribute of the original 
call. This occurs when the value of the DNIS attribute of the original call is 
specified as a value of the key-value pair _ISCC_TRACKING_NUMBER_ in the 
Extensions attribute of the original client request. 

The DNIS matching can be based on any number of digits out of all the digits 
that comprise the DNIS attribute. The number of digits that T-Server should use 
for DNIS matching is specified for the destination switch as the ISCC Protocol 
Parameters property of the Switch Access Code. The value syntax should be as 
follows:

dnis-tail=<number-of-digits> 

Note: To support this transaction type, you must configure your switches to 
pass the UUI provided by your T-Server. You must also ensure that the 
trunks involved do not drop this data.

Notes: This matching criterion is weak because any call that reaches the 
specified DN is considered to be the expected call. Genesys 
recommends that you use this transaction type only in a contact 
center subdivision that can only be reached from within the contact 
center (such as the second line of support, which customers cannot 
contact directly).

When using direct transaction types, Network T-Servers and 
load-sharing IVR Servers are not meant to act as destination 
T-Servers for call routing. Using Network T-Server with these 
transaction types requires special architecture.
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For example, if this property is set to the dnis-tail=7 value, ISCC matches 
only the last seven digits of a DNIS.

You must configure DNIS access resources in the switch; otherwise, ISCC 
fails to use this transaction type and sends EventError in response to the client 
application request.

In Load-Balancing Mode

When T-Server uses load balancing for call routing with the dnis-pool 
transaction type, the following processes occur:

1. A client of the origination T-Server sends a request to pass a call to the 
location with a DNIS access resource specified in the key-value pair 
iscc-selected-dnis. 

2. The origination T-Server distributes the request for a routing service to all 
destination T-Servers. 

3. The destination T-Servers receive the request and check that the specified 
DNIS is not being used by another routing service request.

4. The origination T-Server expects to receive a positive response from each 
destination T-Server. If the origination T-Server receives a negative 
response from at least one T-Server, it sends an EventError to the client and 
clears all data about the request. If the origination T-Server receives the 
confirmation about routing service availability from all destination 
T-Servers, it processes the client’s request and sends a corresponding 
message to the switch. 

5. The origination switch processes the T-Server request and passes the call 
to the destination switch. 

6. The call arrives at the destination switch, which generates an alerting event 
to one of the corresponding load-balanced destination T-Servers. 

7. That destination T-Server processes the call and notifies the origination 
T-Server that the routing service was successful and deletes all information 
about the request.

8. The origination T-Server sends a routing service request cancellation to all 
other destination T-Servers. 

9. The origination T-Server notifies the client that the routing service has 
been successful and deletes all information about the request.

Note: The dnis-pool transaction type is typically used for networks that 
employ a “behind the SCP” architecture, such as network IVR. 
Network T-Server for GenSpec and IServer are two examples of this, 
but other Network T-Servers might also be used in this architecture.



Multi-Site Support ISCC Call Data Transfer Service

T-Server—Deployment Guide 53

pullback

Pullback is used in the following scenario, for those T-Servers that support it: 

1. A call arrives at Site A served by a Network T-Server. 

2. At Site A, a Network T-Server client requests to pass the call by means of 
ISCC routing to Site B served by a premise T-Server. Any transaction type 
except reroute or pullback can be specified in this request.

3. The call arrives at Site B and is either answered by an agent or delivered to 
a routing point.

4. A client of the premise T-Server at Site B sends a TRouteCall or 
TSingleStepTransfer request to transfer the call to the network.

5. The Site B premise T-Server notifies the Network T-Server about this 
request.

6. The network T-Server receives the notification and issues an 
EventRouteRequest to obtain a new destination.

7. After receiving the new destination information, the Network T-Server 
disconnects the call from its current premise location at Site B and attempts 
to route the call to the new destination.

8. The Site B premise T-Server stops tracking the call, which has 
disconnected from the premise’s agent DN or routing point and is delivered 
to the network.

9. The network T-Server completes routing the call to its new destination.

reroute

Reroute is used in the following scenario, for those T-Servers that support it: 

1. A call arrives at Site A served by a Network T-Server. 

2. At Site A, a Network T-Server client requests to pass the call by means of 
ISCC to Site B served by a premise T-Server. Any transaction type except 
reroute or pullback can be specified in this request.

3. An agent at Site B answers the call.

4. A client of the premise T-Server at Site B sends a TSingleStepTransfer or 
TRouteCall request to transfer the call elsewhere (to a PSTN, to an agent, 
or to a routing point).

Note: The transaction type pullback can only be used to return a call from a 
premise T-Server to the Network T-Server that serves the site from 
which the call was previously transferred.
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5. The Site B premise T-Server notifies the Network T-Server about this 
request and releases the call leg that resides at the agent’s phone (using 
TReleaseCall) or at the Routing Point (using TRouteCall with the parameter 
RouteTypeCallDisconnect).

6. The Network T-Server receives the notification and reroutes the call to the 
requested destination by sending EventRouteRequest and attaching the 
call’s user data.

route

With the transaction type route (aliased as route-notoken), a call from the 
origination location reaches a dedicated External Routing Point, and from 
there, it is routed to a destination DN. 

To control configured External Routing Points, T-Server must register these 
DNs with the switch. Failure to register implies that the External Routing Point 
is not available for ISCC purposes. Client applications can register External 
Routing Points via T-Server for monitoring purposes only.

Point-to-Point (One-to-One)

In the Point-to-Point access mode, only one trunk line is used to access an 
External Routing Point (for example, VDN, CDN) at the destination site. See 
Figure 8.

Figure 8: Point-to-Point Trunk Configuration

Notes: The transaction type reroute can only be used to return a call from a 
premise T-Server to the Network T-Server that serves the site from 
which the call was previously transferred.

To perform multi-site operations that are initiated with TRouteCall 
and for which the reroute transaction type is requested, the 
origination T-Server must support the RouteTypeCallDisconnect 
subtype of TRouteCall.

Note: Dedicated DNs of the External Routing Point type must be configured 
in a switch. See “Configuring Multi-Site Support” on page 81.

Trunk Line 1

Trunk Line 2

Trunk Line 3

External Routing Point 1

External Routing Point 2

External Routing Point 3
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Multiple-to-Point (Multiple-to-One)

In the Multiple-to-Point access mode, trunk lines are assigned to the 
destination switch’s trunk group, from which calls are routed to the final 
destination. See Figure 9.

Figure 9: Multiple-to-Point Trunk Configuration

With this configuration, all calls reach the same External Routing Point. The 
DNIS attribute of a specific call differs from that of other calls and uniquely 
identifies the trunk from which the call arrived.

route-uui

The route-uui transaction type employs the dedicated External Routing Point 
feature of the route transaction type (page 54) and the UUI matching feature of 
the direct-uui transaction type (page 50). This transaction type accommodates 
those switches that require a designated External Routing Point even though 
they use UUI for tracking. 

T-Server Transaction Type Support

Table 2 shows which transaction types are supported by a specific T-Server. 
Use this table to determine the transaction types that are available for use with 
your T-Server. This applies both to the cast-type you specify in the 
configuration options for your T-Server, and to any client-designated 
route-type requests specified for transfers of calls. A blank table cell indicates 
that T-Server does not support a certain transaction type.

Note: To switch to this operating mode, you must configure the route-dn 
configuration option for T-Server.

Note: To support this transaction type, you must configure your switches to 
pass the UUI provided by your T-Server. You must also ensure that 
the trunks involved do not drop this data.

Trunk Line 1

External Routing Point
Trunk Line 2

Trunk Line 3
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Table 2: T-Server Support of Transaction Types

T-Server
Type

Transaction Type

route re-
route

direct-
callid

direct-
uui / 

route-
uui

direct-
no-

token

direct-
ani

direct-
digits

direct-
network-

callid

dnis-
pool

pull-
back

one-to-
one

multiple-
to-one

Aastra 
MXONE 
CSTA I

Yes Yesa Yes Yesa

Alcatel 
A4200/OXO

Yes Yes Yes Yes

Alcatel 
A4400/OXE

Yes Yesa,b,c Yesd Yes Yesa Yese

Aspect ACD Yes Yes Yesc Yesf Yesf

Avaya 
Communica- 
tion Manager

Yes Yes Yes Yes

Avaya INDeX Yes Yes Yesb

Avaya TSAPI Yes Yes Yes Yes

Cisco UCCE Yes Yes Yes

Cisco Unified 
Communica- 
tions Manager

Yes Yes Yes Yes

CSTA 
Connector for 
BroadSoft 
BroadWorks

Yes Yes Yes

DataVoice 
Dharma

Yes Yes Yes Yes

Digitro 
AXS/20

Yes Yes Yes

EADS Intecom 
M6880

Yes Yes Yes Yes
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EADS 
Telecom 
M6500

Yes Yes Yes Yes

eOn eQueue Yes Yes Yes

Fujitsu F9600 Yes Yes

Huawei 
C&C08

Yes Yes

Huawei NGN Yes Yes Yes

Mitel MiTAI Yes Yes Yes Yesg

NEC 
NEAX/APEX

Yes Yes Yes Yes

Nortel 
Communica- 
tion Server 
2000/2100

Yes Yesf Yesf Yesf

Nortel 
Communica- 
tion Server 
1000 with 
SCCS/MLS 

Yes Yes Yes Yes Yes

Philips Sopho 
iS3000

Yes Yes Yes Yes

Radvision 
iContact

Yes Yes Yes

Samsung 
IP-PCX IAP

Yes Yes Yes

Siemens 
Hicom 
300/HiPath 
4000 CSTA I

Yes Yes Yesd Yes Yes

Table 2: T-Server Support of Transaction Types (Continued) 

T-Server
Type

Transaction Type

route re-
route

direct-
callid

direct-
uui / 

route-
uui

direct-
no-

token

direct-
ani

direct-
digits

direct-
network-

callid

dnis-
pool

pull-
back

one-to-
one

multiple-
to-one
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Siemens 
HiPath 3000 

Yes Yes Yes

Siemens 
HiPath 4000 
CSTA III

Yes Yesd Yes Yes

Siemens 
HiPath DX

Yes Yesh Yes Yesi

SIP Server Yes Yes Yesj Yes Yes

Spectrum Yes Yes Yes Yesf Yesf

Tadiran Coral Yes Yes Yes Yes

Teltronics 
20-20

Yes Yes Yes Yes

Tenovis 
Integral 33/55

Yes Yes Yes Yes

Network T-Servers

AT&T

Concert

CRSP Yes

DTAG Yes

GenSpec Yes Yes Yes Yes

IVR Server, 
using network 
configuration

Yes Yes Yes Yes Yes

KPN Yes

ISCP

MCI

Table 2: T-Server Support of Transaction Types (Continued) 

T-Server
Type

Transaction Type

route re-
route

direct-
callid

direct-
uui / 

route-
uui

direct-
no-

token

direct-
ani

direct-
digits

direct-
network-

callid

dnis-
pool

pull-
back

one-to-
one

multiple-
to-one



Multi-Site Support ISCC Call Data Transfer Service

T-Server—Deployment Guide 59

Transfer Connect Service Feature

The Transfer Connect Service (TCS) feature supports transfer connect services 
available on some telephony networks. When this feature is enabled, ISCC 
passes user data to remote locations to which calls are transferred or 
conferenced using transfer connect services.

NGSN Yes Yes

Network SIP 
Server

Yes Yes Yes Yes

Sprint Yes

SR-3511

Stentor

a. Not supported in the case of function TRouteCall on a Virtual Routing Point: a Routing Point can be simulated 
using a hunt group with calls being deflected or transferred from the hunt-group member when routing. When a 
two-step (typically mute) transfer is used on such a hunt-group member, CallID and ANI usually change; thus, the 
direct-callid and direct-ani types do not work.

b. Not supported in the case of function TSingleStepTransfer when the T-Server service is simulated using a 
two-step transfer to the switch. In this case, CallID and ANI change; thus, the direct-callid and direct-ani types 
do not work.

c. Not supported if two T-Servers are connected to different nodes.

d. There are some switch-specific limitations when assigning CSTA correlator data UUI to a call.

e. Supported only on ABCF trunks (Alcatel internal network).

f. To use this transaction type, you must select the Use Override check box on the Advanced tab of the DN 
Properties dialog box.

g. Supported only for TRouteCall requests made from a Native Routing Point.

h. Not supported if a TMakeCall request is made.

i. Not supported if a TInitiateTransfer or TInitiateConference request is made from an outgoing call on 
a device.

j. SIP Server supports the direct-uui type.

Table 2: T-Server Support of Transaction Types (Continued) 

T-Server
Type

Transaction Type

route re-
route

direct-
callid

direct-
uui / 

route-
uui

direct-
no-

token

direct-
ani

direct-
digits

direct-
network-

callid

dnis-
pool

pull-
back

one-to-
one

multiple-
to-one
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Procedure:
Activating Transfer Connect Service

Start of procedure

1. Open the T-Server Application’s Properties dialog box.

2. Click the Options tab. 

3. Set the tcs-use configuration option to always.

4. Set the tcs-queue configuration option to the number of a DN on the 
origination switch. 

ISCC uses this DN as an intermediate step when sending calls to the 
remote location. The DN that is configured as tcs-queue receives attached 
data indicating the Feature Access Code (FAC) needed to reach the remote 
site. After a call is directed to the DN with data, a monitoring application 
takes the data and generates the required DTMF (dual-tone 
multifrequency) tones to redirect the call through the network to the remote 
location.

5. When you are finished, click Apply.

6. Click OK to save your changes and exit the Properties dialog box.

End of procedure

ISCC/Call Overflow Feature
The Inter Server Call Control/Call Overflow (ISCC/COF) feature of T-Server, 
that supports passive external routing, is specifically designed to handle calls 
delivered between sites without an explicitly defined destination location. Such 
scenarios include contact center overflows and manual call transfers.

An overflow situation occurs when a call comes into a contact center where all 
agents are currently busy. In this situation, the switch can transfer (overflow) 
the incoming call to another site where there is an available agent.

Note: With T-Server for Avaya Communication Manager, you can use 
RequestRouteCall with RouteTypeOverwriteDNIS to initiate the playing 
of DTMF tones. This is done through the use of another intermediate 
DN (typically, an announcement port configured to give the silent 
treatment), to which the call is routed. When the call is established on 
this DN, T-Server requests that the digits sent in the DNIS field of the 
TRequestRouteCall be played by using the ASAI-send-DTMF-single 
procedure. 
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T-Server uses two methods to handle call overflow and manual transfer 
scenarios. The first method is based on NetworkCallID matching and the second 
method is based on ANI/OtherDN matching.

When connected to each other via switch-specific networks, switches of some 
types can pass additional information along with transferred calls. This 
information may contain the NetworkCallID of a call, which is a networkwide 
unique identifier of the call. 

When connected via a regular PSTN, switches of all types can send the ANI 
and/or OtherDN attributes to the destination switch during any call transfer 
operation.

While all T-Servers support the ISCC/COF feature using the ANI and/or 
OtherDN attributes, only a few support this feature using the NetworkCallID 
attribute. Table 3 shows the T-Server types that provide the NetworkCallID of a 
call.

The ISCC/COF feature can use any of the three attributes (NetworkCallID, 
ANI, or OtherDN) as criteria for matching the arriving call with an existing call 
at another location. Consequently, the attribute that is used determines what 

Table 3: T-Server Support of NetworkCallID for ISCC/COF Feature

T-Server Type Supported NetworkCallID 
Attribute

Alcatel A4400/OXEa

a. Supported only if the match-flexible configuration parameter is used.

Yes

Aspect ACD Yes

Avaya Communication Managera,b 

b. ISCC/COF is cross-compatible between T-Server for Avaya Communication Man-
ager and T-Server for Avaya TSAPI.

Yes

Avaya TSAPIa,b Yes

Cisco UCCE Yes

Mitel MiTAIa Yes

Nortel Communication Server 2000/2100a Yes

Nortel Communication Server 1000 with 
SCCS/MLSa

Yes

SIP Servera Yes

Spectrum Yes
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ConnID, UserData, CallType, and CallHistory are received for the matched 
call from the call’s previous location.

ISCC/COF Call Flow

Figure 10 shows the sequence of steps that occur in an ISCC/COF scenario 
when a call is made or transferred by an agent at Site A to a DN at Site B, or 
when a call is overflowed from Site A to Site B.

Figure 10: Steps in the ISCC/COF Process

Step 1

An agent makes or transfers a call manually to another location or a call is 
overflowed from Site A (origination location) to Site B (destination location).

Warning! Depending on the switch platform, it may be possible to inherit 
the ANI attribute after routing a call to a remote destination, and 
after performing a single-step transfer and other telephone actions. 
However, ISCC/COF works properly only in scenarios where the 
ANI attribute on the destination T-Server is represented by exactly 
the same unique digit string as on the origination T-Server.

Typically, the ANI attribute represents the original call identifier 
(customer phone number), which guarantees that the attribute 
remains unique.

Note: When the ISCC/COF feature is in use, the Number Translation feature 
becomes active. For more information on feature configuration, see 
“Number Translation Feature” on page 64.

2. Call 
passing

Site A Site B
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1. Call made/
transferred to 

another location
3. Arrived call 

notification

5. Call data waiting
7. Call data update

9. Info clearing

T-Server 
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distribution

4. Call data 
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6. Call data 
passing

T-Server T-Server

Origination Switch Destination Switch
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Step 2

Switch A (the origination switch) passes the call to Switch B (the destination 
switch). 

Step 3

The call reaches the destination switch, which notifies the destination T-Server 
about the arrived call.

Step 4

The destination T-Server verifies with remote locations whether the call 
overflowed at any of them.

To determine which calls to check as possibly having overflowed, T-Server 
relies on the Switch object and the presence of DNs on the Switch configured 
as the Access Resource type with the Resource Type set either to cof-in 
(COF-IN DNs) or to cof-not-in (COF-NOT-IN DNs):

T-Server skips an arriving call when one of following conditions is met:

• The call arrives at a DN configured as an Enabled COF-NOT-IN DN.

• COF-IN DNs are configured, but the call arrives at a DN other than one of 
the configured COF-IN DNs or to a COF-IN DN which is Disabled. 

In all other cases, the call is checked for overflow.

To determine which location the call arrived from, T-Server checks the call 
type and checks whether the call has the NetworkCallID, ANI, or OtherDN 
attribute:

• If the call is not an inbound call, the request for call data is sent to all 
remote locations except those whose Switch Access Code has the ISCC 
Call Overflow Parameters property set to inbound-only=true.

• If the call of any type has the NetworkCallID attribute, the destination 
T-Server sends a request for call data to the remote locations of the same 
switch type as the destination location if their Switch Access Codes have 
the ISCC Call Overflow Parameters property set to match-callid.

• If the call of any type has the ANI or OtherDN attribute, the request for call 
data is sent to remote locations whose Switch Access Code has the ISCC 
Call Overflow Parameters property set to match-ani.

Step 5

The destination T-Server waits (suspending events related to that call) for the 
call data from the remote T-Server for the time interval specified in the 
cof-ci-req-tout configuration option. Within this interval, T-Server holds any 
events related to the call. In addition, the cof-ci-defer-delete option on the 
origination T-Server establishes the time interval only after which that 
T-Server deletes the call information. And the cof-ci-wait-all, if set to true, 
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forces the origination T-Server to wait for responses related to possible call 
overflow situations before updating call data.

Step 6

The T-Server at the location from which the call was transferred or overflowed 
sends call data to the requesting T-Server.

Step 7

If a positive response to the call-data request is received, T-Server updates 
ConnID, UserData, CallType, and CallHistory, distributes all suspended 
events related to that call, and deletes all information regarding the transaction 
(Step 9).

Step 8

If the timeout set by cof-ci-req-tout expires, T-Server distributes all 
suspended events, and starts the timeout specified by the cof-rci-tout option. 
If a positive response is received within the timeout set by cof-rci-tout, 
T-Server updates the ConnID, UserData, CallType, and CallHistory, and 
notifies client applications by distributing EventPartyChanged.

Step 9

T-Server deletes all information regarding the transaction when one of these 
results occurs:

• The first positive response to the call-data request is received.

• Negative responses from all queried locations are received.

• The timeout specified by the cof-rci-tout option expires.

Number Translation Feature
The Number Translation feature of T-Server extends the ISCC/COF and 
direct-ani transaction type functions to provide more flexibility for handling 
calls distributed across multiple sites. T-Server translates the input string (ANI 
string) into a number defined by the translation rules. This processing is called 
number translation. T-Servers participating in handling calls at multiple sites 
exchange the translated numbers in order to match the call instances.

The translation process involves two algorithms, one for rule selection and the 
other for the actual translation. Through the first algorithm, T-Server selects a 
rule that will be used for number translation. Through the second algorithm, 
T-Server translates the number according to the selected rule definition. See 
“Number Translation Rules” on page 65 for more information on configuring 
rules for your environment.
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Number translation occurs as follows:

1. The switch reports a number, typically via AttributeANI.

2. T-Server evaluates all configured inbound rules to determine which one is 
the best fit for the received number. The best fit is determined by 
comparing the length of, and the specific digits in, the input number with 
the inbound pattern of each configured rule. See “Rule Examples” on 
page 70 for specific examples.

3. T-Server translates the number according to the selected rule.

To enable T-Server to translate numbers, you must perform specific 
configuration tasks that are associated with translation. See “Configuring 
Number Translation” on page 72.

Number Translation Rules

T-Server uses the number translation rules that you define in the T-Server 
configuration object in two ways:

• Rule selection—To determine which rule should be used for number 
translation

• Number translation—To transform the number according to the selected 
rule

Using ABNF for Rules

The number translation rules must conform to the following syntax, 
represented using Augmented Backus-Naur Form (ABNF) notation. For more 
information about ABNF, see RFC 2234, “Augmented BNF for Syntax 
Specifications: ABNF.”

Common Syntax Notations

Syntax notations common to many of these rules include:

• *—Indicates that 0 to an infinite number of the item following this symbol 
are acceptable.

• 1*—Indicates that one repetition is required. For T-Server, only one 
instance is acceptable.

• /—Indicates that any of the items mentioned, or a combination of those 
items, is acceptable.

Note: The following notation explanations begin with the highest level 
notation. Each explanation includes the name of a component notation 
and a basic definition of each component that it contains. Some 
components require more detailed definitions, which are included 
later in this section.
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Component Notations

Component notations include:

• dialing-plan = *dialing-plan-rule

where:
 dialing-plan-rule represents the name of the rule. Each rule must 

have a unique name. There are no other naming restrictions, and you 
do not need to model your names according to the examples in this 
chapter.

The rules are represented as separate options in the configuration. Also, 
fields from a rule are represented as parameters in a single option string. 

• rule = [name] in-pattern [out-pattern]

where:
 [name] is the name for the rule option, for example, rule-01. In ABNF 

notation, the brackets [] indicate that 0 or 1 instance of the component 
is required. However, for T-Server, a name is required.

 in-pattern is the part of the rule to which T-Server looks when 
attempting to match the input number.

 [out-pattern] is the part of the rule that instructs T-Server on how to 
translate the input number into the required format. The brackets 
indicate that either 0 or 1 instance is required. You must create an 
out-pattern for number translation rules.

• name = *( ALPHA  /  DIGIT  / "-")

where:
 ALPHA indicates that letters can be used in the name for the rule option.
 DIGIT indicates that numbers can be used in the name for the rule 

option.
 “-” indicates that a dash (-) can also be used in the option name, for 

example, rule-01.

• in-pattern = 1*(digit-part / abstract-group)

where:
 digit-part represents numbers. T-Server uses this when selecting the 

most appropriate rule from the entire dialing plan. 
 abstract-group represents one or more letters with each letter 

representing one or more numbers. T-Server uses this when 
transforming a dial string.

For example, [1-9] is the digit-part (representing a range of numbers) 
and ABBB is the abstract-group for in-pattern=[1-9]ABBB.

• out-pattern = 1*(symbol-part / group-identifier) *param-part

where:
 symbol-part represents digits, symbols, or a combination. Symbols are 

rarely used. They are not used in the United States.
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 group-identifier are letters that represent groups of numbers. A letter 
in the out-pattern represents one or more digits, based on the number 
of times the letter is used in the in-pattern. 

 *param-part represents an additional parameter, such as 
phone-context. Reminder: an asterisk means that 0 to an infinite 
number of these are acceptable.

For example, in rule-04; in-pattern=1AAABBBCCC;out-pattern=91ABC, 91 
is the symbol-part; A, B, and C are group-identifiers in the out-pattern, 
each representing three digits, since there are three instances of each in the 
in-pattern.

• digit-part = digits / range  / sequence

where:
 digits are numbers 0 through 9.
 range is a series of digits, for example, 1-3.
 sequence is a set of digits.

• symbol-part = digits / symbols

where:
 digits are numbers 0 through 9.
 symbols include such characters as +, -, and so on.

• range = "[" digits "-"  digits "]" group-identifier

where:
 "[" digits "-"  digits "]" represents the numeric range, for 

example, [1-2].
 group-identifier represents the group to which the number range is 

applied. 

For example, [1-2] applies to group identifier A for 
in-pattern=[1-2]ABBB. When T-Server evaluates the rule to determine 
if it matches the number, it examines whether the first digit of the 
number, identified as group-identifier A, is 1 or 2.

• sequence = "[" 1*(digits [","] ) "]" group-identifier

where:
 "[" 1*(digits [","] ) "]" represents a sequence of digits, separated 

by commas, and bracketed. T-Server requires that each digit set have 
the same number of digits. For example, in [415,650] the sets have 
three digits.

 group-identifier represents the group to which the number sequence 
is applied.

Note: Prefix an out-pattern value with a plus sign (+) for the inbound 
rule when the output must be in a global form (E.164 format).
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For example, in in-pattern=1[415,650]A*B, [415,650] applies to 
group-identifier A. When T-Server evaluates the rule to determine if it 
matches the number, it examines whether the three digits 
(group-identifier A) following the 1 in the number are 415 or 650.

• abstract-group = fixed-length-group / flexible-length-group / entity

where:
 fixed-length-group specifies a group composed of a specific number 

of digits and determined by how many times the group identifier is 
included in the in-pattern. For example, for in-pattern=1AAABBBCCCC, 
there are three digits in group A and B but four in group C.

When you create an out-pattern, you include the group identifier only 
once because the in-pattern tells T-Server how many digits belong in 
that group. For example, rule-04 (see page 70) is 
in-pattern=1AAABBBCCCC; out-pattern=91ABC.

 flexible-length-group specifies a group composed of 0 or more digits 
in the group represented by the group-identifier. For example, in 
in-pattern=1[415,650]A*B, *B represents the flexible length group 
containing the remaining digits in the number.

 entity represents digits defined for a specific purpose, for example, 
country code.

The component abstract-group is used only for the in-pattern.

• fixed-length-group = 1*group-identifier

See the earlier explanation under abstract-group.

• flexible-length-group = “*”  group-identifier

See the earlier explanation under abstract-group.

• entity = “#” entity-identifier group-identifier

where:
 “#” indicates the start of a Country Code entity-identifier.
 entity-identifier must be the letter C which represents Country Code 

when preceded by a pound symbol (#). Any other letter following the # 
causes an error.

 group-identifier represents the Country Code group when preceded 
by #C.

The entity component is a special group that assumes some kind of 
predefined processing, such as the Country Code detection.

• param-part = “;” param-name “=” param-value

where:
 “;” is a required separator element.
 param-name is the name of the parameter.
 “=” is the next required element.

• param-value represents the value for param-name.
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• param-name = “ext” / “phone-context” / “dn”

where:
 “ext” refers to extension.
 “phone-context” represents the value of the phone-context option 

configured on the switch.
 “dn” represents the directory number.

• param-value = 1*ANYSYMBOL

where:
 ANYSYMBOL represents any number, letter, or symbol with no restrictions.

• group-identifier = ALPHA

• entity-identifier = ALPHA

• digits = 1*DIGIT

• symbols = 1*(“-” / “+” / “)” / “(“/ “.”)

Recommendations for Rule Configuration

The configuration of rules for inbound numbers usually depends on the 
settings in the corresponding PBX. These settings often define the form in 
which the PBX notifies its client applications about the number from which an 
inbound call is coming.

As a general guideline, configure rules that define how to process calls from:

• Internal numbers.

• External numbers within the same local dialing area.

• External numbers within the same country.

• International numbers.

Rules for inbound numbers, typically for North American locations, might 
look like this:

1. Two rules to transform internal numbers (extensions): 
name=rule-01;in-pattern=[1-9]ABBB;out-pattern=AB

name=rule-02;in-pattern=[1-9]ABBBB;out-pattern=AB

2. A rule to transform local area code numbers (in 333-1234 format in this 
example):
name=rule-03;in-pattern=[1-9]ABBBBBB;out-pattern=+1222AB

3. A rule to transform U.S. numbers (in +1(222)333-4444 format):
name=rule-04;in-pattern=1AAAAAAAAAA;out-pattern=+1A

4. A rule to transform U.S. numbers without the +1 prefix (in (222)333-4444 
format):
name=rule-05;in-pattern=[2-9]ABBBBBBBBB;out-pattern=+1AB
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5. A rule to transform U.S. numbers with an outside prefix (in 9 
+1(222)333-4444 format):
name=rule-06;in-pattern=91AAAAAAAAAA;out-pattern=+1A

6. A rule to transform international numbers with an IDD (international 
dialing digits) prefix (in 011 +44(111)222-3333 format):
name=rule-07;in-pattern=011*A;out-pattern=+A

7. A rule to transform international numbers without an IDD prefix (in 
+44(111)222-3333 format):
name=rule-08;in-pattern=[2-9]A*B;out-pattern=+AB

Rule Examples

This section provides examples of six rules that are configured as options in 
the Genesys Configuration Database. It also provides examples of how 
T-Server applies rules to various input numbers.

Rules

rule-01 in-pattern=[1-8]ABBB;out-pattern=AB

rule-02 in-pattern=AAAA;out-pattern=A

rule-03 in-pattern=1[415,650]A*B;out-pattern=B

rule-04 in-pattern=1AAABBBCCCC;out-pattern=91ABC

rule-05 in-pattern=*A913BBBB;out-pattern=80407913B

rule-06 in-pattern=011#CA*B;out-pattern=9011AB

Examples

Here are examples of how T-Server applies configured above rules to various 
input numbers.

Example 1 T-Server receives input number 2326.

As a result of the rule selection process, T-Server determines that the matching 
rule is rule-01:

name=rule-01;in-pattern=[1-8]ABBB;out-pattern=AB

The matching count for this rule is 1, because Group A matches the digit 2.

As a result of the parsing process, T-Server detects two groups: Group A = 2 
and Group B = 326.

T-Server formats the output string as 2326.

Example 2 T-Server receives input number 9122.

As a result of the rule selection process, T-Server determines that the matching 
rule is rule-02:

name=rule-02;in-pattern=AAAA;out-pattern=A
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The matching count for this rule is 0; however, the overall length of the input 
number matches that of the in-pattern configuration.

As a result of the parsing process, T-Server detects one group: Group A = 
9122.

T-Server formats the output string as 9122.

Example 3 T-Server receives input number 16503222332.

As a result of the rule selection process, T-Server determines that the matching 
rule is rule-03:

name=rule-03;in-pattern=1[415,650]A*B;out-pattern=B

The matching count for this rule is 4, because the first digit matches and all 
three digits in Group A match.

As a result of the parsing process, T-Server detects two groups: Group A = 650 
and Group B = 3222332.

T-Server formats the output string as 3222332.

Example 4 T-Server receives input number 19253227676.

As a result of the rule selection process, T-Server determines that the matching 
rule is rule-04:

name=rule-04;in-pattern=1AAABBBCCCC;out-pattern=91ABC

The matching count for this rule is 1, because the first digit matches.

As a result of parsing process, T-Server detects three groups: Group A = 925, 
Group B = 322, and Group C = 7676.

T-Server formats the output string as 919253227676.

Example 5 T-Server receives input number 4089137676.

As a result of rule selection process, T-Server determines that the matching 
rule is rule-05:

name=rule-05;in-pattern=*A913BBBB;out-pattern=80407913B

The matching count for this rule is 3, because three digits match.

As a result of the parsing process, T-Server detects two groups: Group A = 408 
and Group B = 7676.

T-Server formats the output string as 804079137676.

Example 6 T-Server receives input number 011441112223333.

As a result of the rule selection process, T-Server determines that the matching 
rule is rule-06:

name=rule-06;in-pattern=011#CA*B;out-pattern=9011AB

The matching count for this rule is 3, because three digits match.

As a result of the parsing process, T-Server detects two groups: Group A = 44 
and Group B = 1112223333.

T-Server formats the output string as 9011441112223333.
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Procedure:
Configuring Number Translation 

Purpose:  To configure the Number Translation feature in T-Server to provide 
more flexibility for handling calls distributed across multiple sites.

Overview

• The Number Translation feature becomes active when the ISCC/COF 
feature and/or the direct-ani transaction type are used.

• This configuration procedure must be completed within the T-Server 
Application object corresponding to your T-Server.

Start of procedure

1. Open the T-Server Application’s Properties dialog box.

2. Click the Options tab. 

3. Create a new section called extrouter or open an existing section with this 
name. 

4. Create a new option called inbound-translator-<n>. This option points to 
another section that describes the translation rules for inbound numbers. 

5. In this section, create one configuration option for each rule. Specify the 
rule name as the option name. The values of these options are the rules for 
the number translation. 

6. When you are finished, click Apply.

7. Click OK to save your changes and exit the Properties dialog box.

End of procedure

Network Attended 
Transfer/Conference Feature

The Network Attended Transfer/Conference (NAT/C) feature is designed to 
enable agents working in multi-site contact centers to consult with each other 
before making call transfers or conferences, regardless of whether both agents 
work at the same or different sites. It also enables the agent who requests a 
consultation to maintain his or her conversation with the customer while the 
system is looking for an available agent and setting up the consultation call. 

The NAT/C feature does not rely on the call transfer capabilities of the local 
switch.
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There are two modes in which the network attended transfer/conference can be 
performed: direct and URS-controlled. Figure 11 shows the sequence of steps 
that occur in URS-controlled mode, when Agent A, who is handling a customer 
call, requests a consultation with another agent, and URS (Universal Routing 
Server) selects Agent B, who is working at another site. The direct mode is 
similar to the URS-controlled mode, with the difference that URS is not 
involved in the process (Step 2 and Step 3 are omitted). 

Figure 11: Steps in the NAT/C Process in URS-Controlled Mode

Step 1

Agent A makes a request for a consultation with another agent. A 
TNetworkConsult request is relayed to the Network T-Server. Depending on the 
parameter settings of the TNetworkConsult request, the NAT/C feature will 
operate in either direct or URS-controlled mode. For more information, see the 
Voice Platform SDK 8.x .NET (or Java) API Reference. 

Step 2

(URS-controlled mode only.) The Network T-Server sends EventRouteRequest 
to URS. 

Step 3

(URS-controlled mode only.) URS locates an available agent at Site B and 
instructs the Network T-Server to route the call to Agent B. The Network 
T-Server confirms the initiation of the network transfer by sending 
EventNetworkCallStatus to T-Server A, which then relays it to Agent A.
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Step 4

The Network T-Server proceeds to obtain the access number from T-Server B, 
and passes the call data to T-Server B. (See “ISCC Call Data Transfer Service” 
on page 41 for details.)

Step 5

The Network T-Server instructs the Service Control Point (SCP) to initiate a 
new voice path with Agent B. Once the connection is confirmed, the Network 
T-Server distributes EventNetworkCallStatus to both T-Server A and T-Server 
B, which then relay it to Agent A and Agent B respectively, to indicate that the 
consultation call is being established.

The Network T-Server also distributes EventRouteUsed to URS to confirm 
successful routing of the call to the selected agent.

Step 6

At this point, the customer is on hold, and Agent A is consulting with Agent B. 
Agent A can do one of the following:

• End the consultation and retrieve the original customer call

• Alternate between Agent B and the customer 

• Set up a conference call with Agent B and the customer

• Transfer the customer call to Agent B

Event Propagation Feature
The Event Propagation feature complements the ISCC and ISCC/COF features 
by distributing updated user data and party-related events to remote T-Servers. 
This feature is used when a call is being made, transferred, or conferenced to 
another location, and when, as a result, one or more instances of the call reside 
at one location while other call instances reside at another location. In this 
scenario, when a client at one location makes changes to user data, updated 
user data is passed (propagated) to T-Servers at other locations. 

The Event Propagation feature consists of User Data update propagation and 
Party Events propagation.

Note: All T-Servers support NAT/C requests with AttributeHomeLocation 
provided that this attribute identifies a network location that is capable 
of processing such requests. Refer to the Network T-Server 
Deployment Guides to determine whether a specific Network T-Server 
can process these requests.
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User Data Propagation

User data propagation takes place when a client at one location makes changes 
to user data associated with a call that was made, transferred, conferenced, or 
routed to other locations. The remote clients involved with the call are notified 
about the changes with EventAttachedDataChanged.

When T-Server receives a local update to user data (that is, when a client of 
this T-Server has changed the call’s user data), T-Server determines if parties 
at remote locations are involved with the call and, if so, sends (propagates) the 
updated user data to the T-Servers at remote locations. 

When T-Server receives a remote update to user data (that is, when a client of a 
remote T-Server has changed the call’s user data and the remote T-Server has 
used the Event Propagation feature to send the updated user data), T-Server:

1. Updates the user data of the corresponding local call.

2. Determines if parties at other remote locations are involved with the call 
and, if so, propagates the updated user data to T-Servers at other remote 
locations. 

The locations to which user data is propagated are selected based on a call 
distribution topology. That is, the updated user data is passed directly to the 
location to which a call was sent and to the location from which the call was 
received, excluding the location from which the update was received.

For example, consider a call made from location A to location B, and then 
conferenced from location B to location C. The three instances of the call 
reside at different locations: the first instance is at location A, the second 
instance is at location B, and the third instance is at location C. The Event 
Propagation feature is employed in the following scenarios:

• When T-Server at location A receives a local update to user data, it notifies 
T-Server at location B (to which it sent the call) about changes to the call’s 
user data. Thus, T-Server at location B receives a remote update to user 
data and, in turn, notifies T-Server at location C (to which it sent the call) 
about these changes. 

Although T-Server at location C receives a remote update to user data, it 
does not pass the notification to any other T-Servers, because it did not 
send the call to any other locations. As mentioned earlier, T-Servers at 
locations B and C update the user data of the corresponding local calls and 
notify their clients about the changes with EventAttachedDataChanged.

• When T-Server at location B receives a local update to user data, it notifies 
T-Server at location C (to which it sent the call) and T-Server at location A 
(from which it received the call) about changes to the call’s user data. 
Thus, T-Servers at locations C and A receive a remote update to user data.

Because T-Server at location C did not send the call to any other locations, 
and T-Server at location A originated the call, neither of these T-Servers 
passes the notification to any other T-Servers. T-Servers at locations C and 
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A update the user data of the corresponding local calls and notify their 
clients about the changes with EventAttachedDataChanged.

• When T-Server at location C receives a local update to user data, it notifies 
T-Server at location B (from which it received the call) about changes to 
the call’s user data. Thus, T-Server at location B receives a remote update 
to user data and, in turn, notifies T-Server at location A (from which it 
received the call) about these changes.

Although T-Server at location A receives a remote update to user data, it 
does not pass the notification to any other T-Servers, because it originated 
the call. T-Servers at locations B and A update the user data of the 
corresponding local calls and notify their clients about the changes with 
EventAttachedDataChanged.

When a call is distributed between location A and location C using location B, 
and is then deleted on location B, propagation between locations A and C still 
occurs through the transit node at location B.

Party Events Propagation

Party events propagation takes place when a transfer or a conference is 
completed for a call that was made to or from one or more remote locations, or 
when a conference party is removed from the conference.

In these cases, the Event Propagation feature distributes party events, such as 
EventPartyChanged, EventPartyAdded, and EventPartyDeleted, to remote 
locations involved with the call, according to appropriate call model scenarios.

For example, consider a call made from DN 1 to DN 2 on location A. A 
TInitiateConference request is then issued for DN 2 to transfer the call to 
external DN 3 on location B. That transfer is made by means of ISCC routing. 
When this conference is completed on location A, the Event Propagation 
feature sends EventPartyChanged to location B and distributes this event to 
involved client applications that are connected to location B and registered for 
DN 3. After that, if a party of the conference is removed from the conference 
(for example, a party on DN 2), the Event Propagation feature sends 
EventPartyDeleted to location B and distributes this event to client applications 
registered for DN 3.

If a call involved in the propagation has no local parties but has two or more 
remote parties, the party events propagation is processed in the same manner 
as the propagation of user data updates.

For a complete event flow in such scenarios, refer to the Genesys Events and 
Models Reference Manual.

Switch Partitioning

A multi-site environment with switch partitioning or intelligent trunks can be 
defined as a configuration of multiple virtual switches (or Switch objects) that 
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are defined in Configuration Manager under a single Switching Office object 
representing a physical switch. Each Switch object has its own instance of a 
T-Server application. All T-Server applications connect to the switch via the 
same or different CTI link or a gateway. (See Figure 12.)

When the Event Propagation feature is active, updated user data and 
party-related events—EventPartyChanged, EventPartyDeleted, and 
EventPartyAdded—are propagated to T-Servers that are involved in call 
transactions, such as transfer or conference. However, with switch partitioning, 
the call instances may reside at one partition or at different partitions.

Figure 12: Switch Partitioning Architecture

Starting with version 8.0, in addition to ConnIDs and UserData, T-Server can 
synchronize the CallType attribute. Each T-Server is required to register all 
DNs it monitors. In a multi-partitioned environment, when configured, calls 
between partitions are reported as internal (CallTypeInternal). In a 
non-partitioned environment, such calls are reported as inbound 
(CallTypeInbound) and/or outbound (CallTypeOutbound), depending on the 
direction of a call. In order for T-Servers to report calls between specified 
partitions as internal, registered DNs of these partitions must be assigned to a 
Switch (T-Server), Switching Office, or Tenant, using the dn-scope 
configuration option. If DNs that are involved in calls are not in the T-Server 
scope, those DNs will be reported as inbound or outbound.

In addition, T-Server supports LocalCallType and PropagatedCallType 
attributes, which depend on the propagated-call-type configuration option 
setting for reporting. 
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To control race conditions that may occur in the switch-partitioned 
environment, use the epp-tout configuration option.

Table 4 shows the T-Server types that support switch partitioning.

Event Propagation Configuration

The basic Event Propagation feature configuration includes a setting of 
specific configuration options at a T-Server Application level. The advanced 
feature configuration allows you to customize the feature at a Switch level. 

When determining whether to notify other T-Servers of changes to user data, 
or to distribute party events, T-Server checks:

1. Call topology (what location a call came from and to what location the call 
was then transferred or conferenced).

2. Outbound parameters of the Switch this T-Server relates to (whether 
propagation parameters are configured for the access codes this switch 
uses to reach the switch at the location a call came from and the switch at 
the location to which the call was then transferred or conferenced).

Notes: Because of possible delays in TCP/IP connections, a sequence of 
events sent for the same call by two or more T-Servers to clients may 
appear in an unexpected order. For example, in a simple call scenario 
with two partitions, EventRinging and EventEstablished messages 
may both arrive before EventDialing.

Genesys switch partitioning does not apply to hardware partitioning 
functionality that is supported on some switches.

Table 4: T-Server Support for Switch Partitioning

T-Server Type Supported

Alcatel A4400/OXE Yes

Avaya Communication Manager Yes

Avaya TSAPI Yes

Cisco Unified Communications Manager Yes

SIP Server Yes

Warning! The direction of user-data or party-events propagation does not 
necessarily match the direction of call distribution. Therefore, the 
access code used to deliver the call can differ from the access code 
used for the purpose of Event Propagation.
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If one of the T-Servers along the call distribution path has the Event 
Propagation feature disabled, that T-Server does not distribute events to remote 
locations.

Procedure:
Activating Event Propagation: basic configuration

Purpose:  To activate the Event Propagation feature for User Data updates and 
call-party–associated events (Party Events) distribution.

Start of procedure

1. Open the T-Server Application’s Properties dialog box.

2. Click the Options tab. 

3. Open the extrouter section. 

4. Set the event-propagation option to the list value. 

This setting enables User Data propagation. If you need to enable Party 
Events propagation, perform Step 5.

5. Set the use-data-from option to the current value.

This setting enables Party Events propagation.

For the option description and its valid values, see the “T-Server Common 
Configuration Options”chapter.

6. When you are finished, click Apply.

7. Click OK to save your changes and exit the Properties dialog box.

End of procedure

Next Steps

• For advanced feature configuration, do the following procedure:

Procedure: Modifying Event Propagation: advanced configuration, on 
page 79

Procedure:
Modifying Event Propagation: advanced configuration

Purpose:  To modify access codes for advanced Event Propagation 
configuration.
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Prerequisites

• Procedure: Activating Event Propagation: basic configuration, on page 79

Overview

You can set Event Propagation parameters using:

• The Default Access Code properties of the Switch that receives an 
ISCC-routed call (the destination switch). 

• The Access Code properties of the Switch that passes an ISCC-routed call 
(the origination switch).

If you do not set up Event Propagation parameters for a given Access Code, 
T-Server uses corresponding settings configured for the Default Access Code 
of the destination switch.

The procedures for modifying Default Access Codes and Access Codes are 
very similar to each other.

Start of procedure

1. Among configured Switches, select the Switch that the configured 
T-Server relates to.

2. Open the Switch’s Properties dialog box and click either the Default 
Access Codes tab or the Access Codes tab.

3. Select a configured Default Access Code or configured Access Code and 
click Edit.

4. In the Switch Access Code Properties dialog box that opens, specify a value 
for the ISCC Protocol Parameters field as follows:
 To enable distribution of both user data associated with the call and 

call-party–associated events1, type:

propagate=yes

which is the default value.
 To enable distribution of user data associated with the call and disable 

distribution of call-party–associated events, type:

propagate=udata

 To disable distribution of user data associated with the call and enable 
distribution of call-party–associated events, type:

Note: If no Default Access Code is configured, see page 84 for 
instructions. If no Access Codes are configured, see page 85 for 
instructions.

1.  The following are call-party–associated events: EventPartyChanged, EventPartyDe-
leted, and EventPartyAdded.
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propagate=party

 To disable distribution of both user data associated with the call and 
call-party–associated events, type:
propagate=no

5. Click OK to save configuration updates and close the Switch Access Code 
Properties dialog box.

6. Click Apply and OK to save configuration updates and close the Switch 
Properties dialog box.

End of procedure

ISCC Transaction Monitoring Feature
This feature allows T-Server clients to monitor ISCC transactions that occur 
during the call data transfer between T-Servers in a multi-site environment.

In order to be able to monitor ISCC messaging, a T-Server client must 
subscribe to the ISCC Transaction Monitoring. Once a subscription request is 
confirmed, a client will receive updates about all multi-site operations of this 
T-Server. 

The TTransactionMonitoring request is used to instruct T-Server to start, stop, 
or modify a client’s subscription to Transaction Monitoring feature 
notifications by setting the TSubscriptionOperationType parameter to 
SubscriptionStart, SubscriptionStop, or SubscriptionModify respectively. 
The transaction status is reported in EventTransactionStatus messages to the 
subscribed clients.

To determine whether the Transaction Monitoring feature is supported by a 
specific T-Server, a T-Server client may query T-Server’s capabilities. For 
more information about support of this feature, see Genesys Events and Models 
Reference Manual and Voice Platform SDK 8.x .NET (or Java) API Reference.

Configuring Multi-Site Support
Prior to configuring T-Server to support multi-site operation, you must read the 
“Licensing Requirements” on page 15, as well as previous sections of this 
chapter on multi-site deployment. In particular, Table 2 on page 56 shows 
which transaction types are supported by a specific T-Server, while Table 3 on 
page 61 shows whether your T-Server supports the NetworkCallID attribute for 
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the ISCC/COF feature. Use this information as you follow the instructions in 
this chapter.

For T-Server to support multi-site operation, you must create and configure 
three types of objects in the Configuration Layer: 

1. Applications

2. Switches, including Access Codes

3. DNs

You must configure these objects for origination and destination locations. 
Multi-site support features activate automatically at T-Server startup. See 
“DNs” on page 89 for details. 

Applications

Ensure that T-Server Application objects, and their corresponding Host 
objects, exist and are configured for origination and destination locations. 

Once you’ve done that, use Configuration Manager to add this configuration to 
a T-Server Application.

Procedure:
Configuring T-Server Applications

Purpose:  To configure T-Server Application objects for multi-site operation 
support.

Start of procedure

1. Open the T-Server Application’s Properties dialog box.

2. Click the Connections tab and click Add to add a connection to the 
appropriate T-Server. The Connection Info Properties dialog box displays.

3. Use the Browse button to search for the T-Server you want to connect to, 
and fill in the following values:
 Port ID
 Connection Protocol

Note: Before attempting to configure a multi-site environment, Genesys 
recommends that you plan the changes you want to make to your 
existing contact centers. You should then gather the configuration 
information you will need (such as the name of each T-Server 
application, port assignments, and switch names), and use 
Configuration Manager to create and partially configure each T-Server 
object. Review option values in the extrouter section and determine 
what these values need to be, based on your network topology.
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 Local Timeout
 Remote Timeout
 Trace Mode

4. Click the Options tab. Create a new section called extrouter or open an 
existing section with this name. 

5. Open the extrouter section. Configure the options used for multi-site 
support.

6. When you are finished, click Apply.

7. Repeat this procedure for all T-Servers for origination and destination 
locations that are used for multi-site operations.

End of procedure

Next Steps

• See “Switches and Access Codes.”

Switches and Access Codes

Ensure that Switching Office and Switch objects are configured for both 
origination and destination locations.

You configure Access Codes to a destination switch in the origination Switch’s 
Properties dialog box. The only exception is the Default Access Code, which 
is configured at the destination Switch’s Properties dialog box.

You can configure two types of switch Access Codes in the Switch’s 
Properties dialog box:

• A Default Access Code (for inbound calls)—Specifies the access code that 
other switches can use to access this switch when they originate a 
multi-site transaction.

• An Access Code (for outbound calls)—Specifies the access code that this 
switch can use when it originates a multi-site transaction to access another 
switch.

When the origination T-Server processes a multi-site transaction, it looks for 
an access code to the destination switch. First, T-Server checks the Access 
Code of the origination Switch: 

• If an access code to the destination switch is configured with the target 
type Target ISCC and with any transaction type except Forbidden, T-Server 
uses this access code to dial the destination switch.

Note: If you do not create the extrouter section, T-Server uses the 
default values of the corresponding configuration options.
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• If the access code to the destination switch is not configured on the Access 
Code tab of the origination switch, the origination T-Server checks the 
Default Access Code tab of the destination switch. If an access code is 
configured there with the target type Target ISCC and with any transaction 
type except Forbidden, T-Server uses this access code to dial the 
destination switch. 

• If no access code with the required properties is found, T-Server rejects the 
transaction.

Procedure:
Configuring Default Access Codes

Purpose:  To configure the Default Access Codes (one per Switch object) to be 
used by other switches to access this switch when they originate a multi-site 
transaction.

Prerequisites

• Ensure that Switching Office and Switch objects are configured for both 
origination and destination locations.

Start of procedure

1. Among configured Switches, select the Switch that the configured T-Server 
relates to.

2. Open the Switch Properties dialog box and click the Default Access Codes 
tab.

3. Click Add to open the Access Code Properties dialog box.

4. In the Code field, specify the access code used by remote switches to reach 
a DN at this switch. An access code is used as a prefix to the remote switch 
numbers. 

5. In the Target Type field, select Target ISCC.

6. In the Route Type field, select a value corresponding to the transaction type 
you want to use (given that it is supported for your switch type).

Note: When migrating from previous releases of T-Servers to 8.1, or when 
using T-Servers of different releases (including 8.1) in the same 
environment, see “Compatibility Notes” on page 88.

Note: If no prefix is needed to dial to the configured switch, you can 
leave the Code field blank. 
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7. When you are finished, click Apply.

End of procedure

Next Steps

• See “Configuring Access Codes.”

Procedure:
Configuring Access Codes

Purpose:  To configure the Access Codes (one or more per Switch object) that 
this switch can use when it originates a multi-site transaction to access another 
switch.

Prerequisites

• Ensure that Switching Office and Switch objects are configured for both 
origination and destination locations.

Start of procedure

1. Among configured Switches, select the Switch that the configured T-Server 
relates to.

2. Open the Switch Properties dialog box and click the Access Codes tab.

3. Click Add to open the Access Code Properties dialog box.

4. In the Switch field, specify the switch that this switch can reach using this 
access code. Use the Browse button to locate the remote switch.

5. In the Code field, specify the access code used to reach a DN at the remote 
switch from this switch. An access code is used as a prefix to the remote 
switch numbers.

6. In the Target Type field, select Target ISCC. 

When you select Target ISCC as your target type, the Properties dialog 
box changes its lower pane to the Sources pane. It is here that you enter the 
extended parameters for your access codes, by specifying the ISCC 
Protocol and ISCC Call Overflow Parameters. 

Note: If no prefix is needed to dial from one switch to another, you can 
leave the Code field blank.
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To set these parameters, locate the two drop-down boxes that appear below 
the Target Type field in the Sources pane of that Properties dialog box.

a. In the ISCC Protocol Parameters drop-down box, enter the appropriate 
ISCC Protocol parameter, as a comma-separated list of one or more of 
the following items shown in Table 5:

b. In the ISCC Call Overflow Parameters drop-down box, enter call 
overflow parameters, as a comma-separated list of one or more of the 
following items shown in Table 6:

Table 5: Target Type: ISCC Protocol Parameters

ISCC Protocol Parameters Description

dnis-tail=<number-of-digits> Where number-of-digits is the number 
of significant DNIS digits (last digits) 
used for call matching. 0 (zero) matches 
all digits.

propagate=<yes, udata, party, no> Default is yes. For more information, see 
“Modifying Event Propagation: advanced 
configuration” on page 79. 

direct-network-callid=<> Use Table 3 on page 61 to determine if 
your T-Server supports the 
direct-network-callid transaction type.

Table 6: Target Type: ISCC Call Overflow Parameters

ISCC Call Overflow Parameters Description

match-callid Matches calls using network CallID.

match-ani Matches calls using ANI.

Note: When using match-ani, the 
match-flexible parameter must be set to 
false.
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7. In the Route Type field, select a value corresponding to the transaction type 
you want to use (given that it is supported for your switch type). Table 7 
contains cross-reference information on transaction types that the 
Configuration Layer and T-Server use.

match-flexible Supports flexible call matching based on 
the following values:

Default Value: true

Valid Values: true, false, and 
[matching-context-type], where 
[matching-context-type] is the 
switch-specific value, which must be the 
same as the value of the 
default-network-call-id-matching 
configuration option of the corresponding 
T-Server.

inbound-only=<boolean> Default is true. Setting inbound-only 
to true disables COF on consultation 
and outbound calls. 

Table 7: Route Type and ISCC Transaction Type Cross-Reference

Route Type Field Value ISCC Transaction Type

Default The first value from the list of values 
specified in the cast-type option for the 
T-Server at the destination site

Direct direct-callid

Direct ANI direct-ani

Direct Digits direct-digits

Direct DNIS and ANI Reserved

Direct Network Call ID direct-network-callid

Direct No Token direct-notoken

Direct UUI direct-uui

DNIS Pooling dnis-pooling

Table 6: Target Type: ISCC Call Overflow Parameters (Continued) 

ISCC Call Overflow Parameters Description
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8. When you are finished, click Apply.

End of procedure

Next Steps

• After configuring a switch for multi-site support, proceed with the 
configuration of DNs assigned to this switch.

Compatibility Notes

When migrating from previous releases of T-Servers to 8.1, or when using 
T-Servers of different releases (including 8.1) in the same environment, keep 
in mind the following compatibility issues:

• The Target External Routing Point value of the Target Type field is 
obsolete and provided only for backward compatibility with T-Servers of 
releases 5.1 and 6.0. When two access codes for the same switch are 
configured, one with the Target ISCC target type and the other with the 
Target External Routing Point target type, T-Servers of releases 8.x, 7.x, 
6.5, and 6.1: 
 Use the Target ISCC access code for transactions with T-Servers of 

releases 8.x, 7.x, 6.5, and 6.1.
 Use the Target External Routing Point access code for transactions 

with T-Servers of releases 5.1 and 6.0. 

When the only access code configured for a switch has the Target External 
Routing Point target type, T-Server uses this access code for all 
transactions. 

• When the Target External Routing Point value of the Target Type field is 
configured, you must set the Route Type field to one of the following:
 Default to enable the route transaction type
 Label to enable the direct-ani transaction type

Forbidden External routing to this destination is not 
allowed

ISCC defined protocol Reserved

PullBack pullback

Re-Route reroute

Route route

Table 7: Route Type and ISCC Transaction Type Cross-Reference
 (Continued) 

Route Type Field Value ISCC Transaction Type
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 Direct to enable the direct transaction type

 UseExtProtocol to enable the direct-uui transaction type
 PostFeature to enable the reroute transaction type

These values are fully compatible with the transaction types supported in 
T-Server release 5.1.

• For successful multi-site operations between any two locations served by 
release 5.1 T-Servers, identical Route Type values must be set in the 
Switch’s Access Code Properties dialog boxes for both the origination and 
destination switches.

DNs

Use the procedures from this section to configure access resources for various 
transaction types.

Procedure:
Configuring access resources for the route 
transaction type 

Purpose:  To configure dedicated DNs required for the route transaction type.

Prerequisites

• Ensure that Switching Office and Switch objects are configured for both 
origination and destination locations.

Start of procedure

1. Under a configured Switch, select the DNs folder. From the main menu, 
select File > New > DN to create a new DN object.

2. On the General tab of the DN’s Properties dialog box, specify the number 
of the configured DN as the value of the Number field. This value must 
correspond to the Routing Point number on the switch.

3. Select External Routing Point as the value of the Type field.

4. If a dialable number for that Routing Point is different from its DN name, 
specify the number in the Association field.

5. Click the Access Numbers tab. Click Add and specify these access number 
parameters: 
 Origination switch.

Note: The direct transaction type in releases 5.1 and 6.0 corresponds to 
the direct-callid transaction type in releases 6.1 and later.
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 Access number that must be dialed to reach this DN from the 
origination switch.

In determining an access number for the Routing Point, T-Server composes 
it of the values of the following properties (in the order listed):

a. Access number (if specified).

b. Switch access code from the switch of the origination party to the 
switch to which the Routing Point belongs, concatenated with its 
Association (if the Association value is specified).

c. Switch access code from the switch of the origination party to the 
switch to which the Routing Point belongs, concatenated with the 
number for the DN.

d. Default access code of the switch to which the Routing Point belongs, 
concatenated with its Association (if the Association value is 
specified).

e. Default access code of the switch to which the Routing Point belongs, 
concatenated with the number for the DN.

6. When you are finished, click Apply.

End of procedure

Procedure:
Configuring access resources for the dnis-pool 
transaction type 

Purpose:  To configure dedicated DNs required for the dnis-pool transaction 
type.

Start of procedure

1. Under a configured Switch, select the DNs folder. From the main menu, 
select File > New > DN to create a new DN object.

2. On the General tab of the DN’s Properties dialog box, specify the number 
of the configured DN as the value of the Number field. This value must be a 
dialable number on the switch.

3. Select Access Resource as the Type field and type dnis as the value of the 
Resource Type field on the Advanced tab.

Note: If option use-implicit-access-numbers is set to true, the access 
number composed of switch access code and DN can be used for 
external transfers of calls originating at switches for which an 
access number is not specified.
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4. Click the Access Numbers tab. Click Add and specify these Access Number 
parameters: 
 Origination switch.
 Access number that must be dialed to reach this DN from the 

origination switch.

An access number for the access resource is determined in the same 
manner as for the route access resource.

5. When you are finished, click Apply.

End of procedure

Procedure:
Configuring access resources for direct-* transaction 
types 

Start of procedure

You can use any configured DN as an access resource for the direct-* 
transaction types. (The * symbol stands for any of the following: callid, uui, 
notoken, ani, or digits.)

You can select the Use Override check box on the Advanced tab to indicate 
whether the override value should be used instead of the number value to dial 
to the DN. You must specify this value if the DN has a different DN name and 
dialable number. In fact, this value is required for T-Servers for some switch 
types—such as Aspect ACD, Nortel Communication Server 2000/2100, and 
Spectrum.

End of procedure

Procedure:
Configuring access resources for ISCC/COF

Purpose:  To configure dedicated DNs required for the ISCC/COF feature.
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Start of procedure

1. Under a configured Switch, select the DNs folder. From the main menu, 
select File > New > DN to create a new DN object.

2. On the General tab of the DN Properties dialog box, enter the name of the 
configured DN in the Number field. 

3. Select Access Resource as the value for the Type field.

4. On the Advanced tab, type cof-in or cof-not-in as the value for the 
Resource Type field. 

5. When you are finished, click Apply.

End of procedure

Procedure:
Configuring access resources for non-unique ANI

Purpose:  To configure dedicated DNs required for the non-unique-ani 
resource type. 

The non-unique-ani resource type is used to block direct-ani and COF/ani 
from relaying on ANI when it matches configured/enabled resource digits. 
Using non-unique-ani, T-Server checks every ANI against a list of 
non-unique-ani resources. 

Start of procedure

1. Under a configured Switch, select the DNs folder. From the main menu, 
select File > New > DN to create a new DN object.

2. On the General tab of the DN Properties dialog box, specify the ANI 
digits that need to be excluded from normal processing. 

Note: Use Table 3 on page 61 to determine if your T-Server supports the 
ISCC/COF feature.

Note: The name of a DN of type Access Resource must match the name 
of a DN in your configuration environment (typically, a DN of 
type Routing Point or ACD Queue), so T-Server can determine 
whether the calls arriving at this DN are overflowed calls.

Note: Calls coming to DNs with the cof-not-in value for the Resource 
Type are never considered to be overflowed.
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3. Select Access Resource as the value for the Type field. 

4. On the Advanced tab, specify the Resource Type field as non-unique-ani. 

5. When you are finished, click Apply.

End of procedure

Procedure:
Modifying DNs for isolated switch partitioning

Purpose:  To modify DNs that belong to a particular partition where switch 
partitioning is used. 

This configuration instructs T-Server to select an External Routing Point that 
has the same partition as the requested destination DN. 

Start of procedure

1. Under a Switch object, select the DNs folder. 

2. Open the Properties dialog box of a particular DN.

3. Click the Annex tab.

4. Create a new section named TServer.

5. Within that section, create a new option named epn. Set the option value to 
the partition name to which the DN belongs.

6. Repeat Steps 1–5 for all DNs, including DNs of the External Routing Point 
type, that belong to the same switch partition.

7. When you are finished, click Apply.

End of procedure

Configuration Examples

This section provides two configuration examples and describes how the 
configuration settings affect T-Server’s behavior.

Multiple Transaction Types

This example demonstrates the difference in how ISCC directs a call when you 
specify two different transaction types (route and direct-ani).

Note: When a target DN is not configured or has no configured partition 
name, T-Server allocates a DN of the External Routing Point type that 
belongs to any partition.
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In this example, you configure an origination and a destination switch for as 
described in “Switches and Access Codes” on page 83.

1. Among configured Switches, select the origination Switch.

2. Open the Switch Properties dialog box and click the Default Access Codes 
tab.

3. Click Add to open the Access Code Properties dialog box.

4. Set the Access Code field to 9. 

5. When you are finished, click Apply.

6. Among configured Switches, select the destination Switch. 

7. Under the destination Switch, configure a DN as described in 
“Configuring access resources for the route transaction type” on page 89.

8. Set the DN Number field to 5001234567. 

9. Click the Advanced tab of this DN’s Properties dialog box.

10. Select the Use Override check box and enter 1234567 in the Use Override 
field. 

11. When you are finished, click Apply or Save.

12. Use a T-Server client application to register for this new DN with the 
destination T-Server and, therefore, with the switch.

13. Request to route a call from any DN at the origination switch to the 
destination DN you have just configured:
 If you are using the route ISCC transaction type, the client requests 

that T-Server deliver a call to a destination location using the DN 
number 5001234567. ISCC requests that the switch dial one of the 
external routing points at the destination location, using the value 
either of the Access Number field or of the Access Code field, which is 9, 
concatenated with the external routing point at the destination location. 
The call is routed to the DN number 5001234567.

 If you are using the direct-ani ISCC transaction type, the client 
requests that T-Server deliver a call to a destination location using the 
DN number 1234567, which is the Use Override value. ISCC requests 
that the switch dial 91234567, which is a combination of the Switch 
Access Code value and the Use Override value. The destination T-Server 
is waiting for the call to directly arrive at DN number 5001234567.

Call Overflow Methods

This section demonstrates how to indicate which overflow methods a switch 
supports. 

In this example, for T-Server to use ANI/OtherDN matching in call overflow 
and manual transfer scenarios, set the ISCC Call Overflow Parameters to:

match-ani, inbound-only=true
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when configuring Switch Access Codes as described on page 85.

With this setting, the switch’s location is queried for call data each time the 
destination T-Server receives an inbound call with the ANI or OtherDN attribute. 

For T-Server to use NetworkCallID matching in call overflow and manual 
transfer scenarios, set the ISCC Call Overflow Parameters to (for example):

match-callid, inbound-only=false

when configuring Switch Access Codes as described on page 85.

With this setting, the switch’s location is queried for call data each time the 
destination T-Server receives a call of any type (including inbound) with the 
NetworkCallID attribute. 

Next Steps
Continue with Chapter 5, “Starting and Stopping T-Server and CSTA 
Connector,” on page 97 to test your configuration and installation.
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